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Introduction

Voici plus d'un an et demi que Corel mettait à disposition des utilisateurs de Linux sa
suite graphique Corel Draw9. Commercial, cet ensemble d'outils graphiques
professionnels présentait la particularité d'offrir gracieusement son module de retouche
d'images en mode point: PhotoPaint9. On en était, pour les utilisateurs de Mandrake, à
la version 7.0 de leur distribution.
L'installation de PhotoPaint9, qui se déroulait alors sans difficultés aucune, devint
apparemment impossible sur les versions ultérieures des Mandrake, ce qui n'est pas
sans causer quelques regrets aux amateurs, tant les outils du niveau technique de
PhotoPaint font défaut sous Linux. Soit dit sans vouloir offenser les Gimpeurs... dont je
suis.
De plus, la tourmente financière qui a frappé Corel a vu arriver Microsoft en sauveur
masqué avec, pour conséquences immédiates l'abandon de Linux par le racheté de
frais. Un inconnu, Xandros, a cependant repris une partie du flambeau tombé, à savoir
CorelOS, en négligeant PhotoPaint. Le triste site de Xandros n'en fait même pas
mention. Et l'oubli pouvait maintenant s'appesantir sur le soft...

Mais voilà: un linuxien est têtu et son OS n'est pas vérouillé au point qu'il ne puisse y
plonger aux tréfonds des entrailles à la recherche de ce qui bloque. Et de trouver.

Car, c'est heureux, il y a une solution, du moins pour les derniers opus de Mandrake.
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1 L'installation

Il convient en premier lieu de s'armer d'un CD contenant l'archive du programme à
installer et d'un état d'esprit déstressé.
Tout d'abord, se connetcter en root. Cela peut paraître une hérésie, mais bien que
l'installation ait été prévue pour se dérouler à partir d'un terminal en mode SU, des
dysfonctionnements surviennent: il n' y a donc pas d'autre solution. Se placer ensuite
dans le répertoire CorelPhotoPaint (qui peut porter un autre nom) du CD et entrer
./install. Normalement, la procédure se déroulera sans anicroche. Un répertoire
/usr/lib/corel ainsi qu'un lien symbolique /usr/bin/photopaint qui pointe sur le lanceur
idoine du programme seront créés.
Se déconnecter de root, et se connecter en tant qu'utilisateur, pour vérifier l'état de
l'installation effectuée. En effet, pour des raisons de sécurité, PhotoPaint ne se lance
pas en root.
Ouvrir un terminal et à l'invite, entrer: photopaint, ou, alt+F2 dans KDE.
Et....
Cela ne doit pas fonctionner.
L'avantage d'avoir lancé l'application dans un terminal permet de connaître la nature du
problème, ce que n'aurait pas permis l'emploi de Alt+F2. On découvre donc que le
serveur de polices spécifique de Corel, FontTastic, n'est pas installé.
Il s'agit donc maintenant de finir à la MAIN ce que l'installateur n'a pu réaliser.Pour cela,
il faut récupérer l'archive de FontTastic sur le CD:

./dists/redhat/i386/fonttastic−glibc−2.1−2000.06.22.14.00−1.i386.rpm

ATTENTION à ne pas confondre avec l'archive pour glibc−2.0.
Cette archive est à copier dans un répertoire temporaire, /tmp par exemple. Si l'on
essaye de l'installer avec Software Installer, à partir de Krusader qui est si pratique, on
se heurte à un echec pour cause de conflit avec des versions différentes de initscript.
Mais il ne sera pas dit qu'un linuxien sera moins rusé que son système! Sans ambage,
ledit linuxien va décompresser l'archive dans le répertoire temporaire.
Une arborescence fonttastic... est alors créée dans /tmp, contenant les sous−réperoires:
./etc,
./usr et ../var.
Chaque répertoire contient des sous−répertoires et/ou des fichiers qui, lors d'une
installation correcte, se seraient placés dans l'arborescence du système dont celle
créée dans /tmp est une image. On comprend que puisqu'ils n'y sont pas, il va falloir les
y copier (ou déplacer).
Pour ce faire, ouvrir un terminal et passer en mode SU.

Copier les trois fichiers: cachegen, fontfs et ftfi de ../usr/X11R6/bin dans /usr/X11R6/bin
du système.
Opérer de façon analogue avec le contenu de ../usr/X11R6/share si l'on veut la
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documentation relative à ce serveur de polices. Ceci est simple. La suite demande
d'avancer un peu plus à tâtons.

En effet, le problème d'installation viendrait du contenu de ../etc.
On y trouve ceci:
./etc/init.d/fonttastic (592 octets)
./etc/rc.d/init.d/fonttastic (2309 octets)

Or sur la Mandrake 8, distribution sur laquelle on est en train d'installer PhotoPaint,
/etc/init.d est un lien symbolique pointant sur /etc/rc.d/init.d

On comprend que l'on ne pourra pas installer deux fichiers fonttastic différents (celui de
592 octets et celui de 2309 octets) au même endroit: il y en a un de trop!
Après essais, il apparaît qu'il convient de copier ../etc/rc.d/init.d/fonttastic (2309 octets)
du répertoire temporaire dans /etc/rc.d/init.d du système.
Ce fichier étant un script exécutable, rendre actif le serveur de police en lançant la
commande (en SU):
/etc/rc.d/int.d/fonttastic start.

Le serveur de polices est dès lors immédiatement actif.
Repasser en mode utilisateur. Si l'on est sous KDE, faire alt+F2, et entrer dans le
champ du lanceur: photopaint.
Et roulez, jeunesse! Ca marche. A vous les superbes effets 3D, les creatives, weather...
la gestion CMJN, les exports PSD et autres qui n'existent pas dans Gimp, hélas!

En a−t'on fini pour autant? Non, puisque lors d'un nouveau lancement de Linux, l'appel
de PhotoPaint provoquera le démarrage de FontTastic et de l'initialisation des polices,
ce qui est assez long. Aussi, est−il préférable d'automatiser l'exécution de ce serveur.
Pour cela il suffit de céer dans /etc/rc2.d, /etc/rc3.d, rc4.d et rc5.d un lien symbolique
S100ftastic (par exemple) pointant sur /etc/rc.d/init.d/fonttastic.

Et c'est fini. Heureusement.
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2 Premier contact: l'ouverture .

Au démarrage, un écran d'accueil s'ouvre, avec une barre de progression indiquant
l'état de chargement du programme en mémoire. Des noms s'inscrivent également,
avec de curieuses extensions dans le monde Linux: dll. Pas de doute, il s'agit d'un
programme Windows qui s'éxécute grâce à une version spécifique de Wine, mise en
place, configurée, livrée prête à l'emploi  lors de l'installation décrite plus avant.
Mais qu'on se rassure: si, au premier lancement, une initialisation des polices, générant
les fichiers ~/.graphics9/cachedafm et cachedmetric est assez longue, ceci n'a plus lieu
par la suite.  Il faudra alors 7 secondes (sur ma machine) pour que PhotoPaint soit
entièrement chargé. Il en faut 5 à Gimp, pourtant en code natif, à chaque lancement car
celui−ci écrit chaque fois ~/.gimp−1.2/menurc, parasiterc, unitrc et pluginrc.

Notons que l'écran d'accueil avec barre de progression ne s'est plus affiché à la suite de
je ne sais quelle malencontreuse manipulation de ma part. PhotoPaint n'en continue pas
moins de fonctionner normalement, sauf à l'arrêt où il signale une superbe erreur dans
le plus pur style Windows. Cela tient à ce qu'à l'arrêt, Wine cherche à fermer tout ce qu'il
a ouvert, même ce qu'il n'a pas résussi à ouvrir. Pour éviter l'apparition de ce message
irritant, il y a deux solutions: soit trouver pourquoi progress−gui ne se lance plus au
démarrage, soit interdire tout simplment son lancement. C'est la solution que j'ai choisie,
et, il est bon de le répéter, cela n'affecte en rien le fonctionnement de Photopaint .
Pour ce faire, ouvrir avec son éditeur préféré (en mode SU) le script:
/usr/lib/corel/graphics9/bin/gfxlauncher, et commenter la ligne en cause comme ci après:

# Used for displaying messages
KMESSAGE=/usr/lib/corel/Graphics9/bin/kmessage
# Used for displaying the progress dialog
#PROGRESS_GUI=/usr/lib/corel/wine−graphics9/bin/progress−gui <======

Le lancement de progress−gui ne se fera donc plus, et le script d'arrêt, closeGraphics9 ,
ne rencontrera plus de difficultés.
Le progress−gui ayant disparu, dès que PhotoPaint est prêt à être utilisé, une fenêtre de
bienvenue propose plusieurs activités. Si l'on ne désire plus commencer ainsi, il faut
paramétrer le lancement dans >Tools>Options>Worksapce>General> On Startup. Les
options disponibles sont: Welcome screen, New File, Open File, Run Script, Nothing.
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Par défaut, si aucune configuration de l'espace, le Workspace, n'a été effectuée, le
Welcome Screen s'affiche. Nous reparlerons des possibilités présentées dans cet écran
d'accueil.
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3 L'interface

L'interface regroupe toutes les commandes et toutes les informations autour de l'espace
de travail occupé par l'image en cours d'édition. A gauche, la boîte à outils; au sommet,
la barre d'outils contextuels; à droite, "l'établi" bien ordonné, comme dans Moonlight,
avec des onglets verticaux permettant de faire passer au premier plan la palette voulue;
enfin, en bas, la ligne d'état.
Un long et houleux débat a eu lieu sur le forum de Linuxgraphic à propos de la
convivialité de ce type d'interface comparé à celui de Gimp. Il semblerait que la
subjectivité ait été de rigueur, ce qui est normal: le meilleur outil est celui que l'on tient
bien en main. Pour ma part, je préfère infiniment l'interface de PhotoPaint à la joyeuse
anarchie de Gimp, où les fenêtres n'en finissent pas de s'escalader pour se recouvrir à
qui mieux mieux. La bohême, c'est beau dans une chanson d'Aznavour; c'est moins
pratique dans l'espace de travail limité d'un écran d'ordinateur.
Quoi qu'il en soit, PhotoPaint n'est pas rigide. L'interface est modulable et chacun peut
la définir à son goût, puis la sauvegarder afin de la retrouver à l'ouverture des
prochaines sessions. Il y a même par défaut une interface style PhotoShop pour celui
qui a acquis des automatismes tels qu'il ne puisse s'en passer. A lui alors les palettes
flottantes si peu agréables (provocation!).
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4 Editer une image

Si l'on choisit New Image en session de travail, une boîte de dialogue permet de choisir
les caractéristiques de l'image que l'on va créer. Certaines options sont des plus
classiques:
Size: dimensions prédéfinies ou au choix de l'utilisateur (custom)
Résolution: prédéfinies, mais atteignant 600 dpi pour une qualité professionnelle
destinée à l'impression.
Unités: beaucoup plus original, puisqu'il est possible de définir l'image en didots ou
picas par exemple qui sont des unités utilisées par les imprimeurs et les metteurs en
page.
Color mode: c'est ici que PhotoPaint se distingue puisqu'il propose, outre les modes
classiques de niveaux de gris, de palette indexée et de RVB, le mode LAB et surtout le
mode professionnel 32 bit CMJN, qui fait tant défaut à Gimp pour qu'il pénètre les
studios de création et les imprimeries.

Et pour finir sur le sujet, on remarquera également la présence de l'option Create a
movie et Number of frame, pour l'élaboration de gif animés, ainsi que des informations
concernant l'espace mémoire requis par l'image à créer selon les paramètres que l'on
vient de déterminer.
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5 Ouvrir une Image

Si l'on choisit Open Image, une boîte de dialogue s'ouvre présentant une fenêtre de
sélection de fichier, une très commode possibilité d'aperçu et un sélecteur de type de
fichiers. On en compte une cinquantaine, en mode point, ce qui n'a rien d'original, et en
mode vectoriel, ce qui est plus rare.
Ainsi peut−on lire des WMF, CGM, DRW, CDR, GEM, EPS, WPG, AI ainsi que DWG et
DXF qui sont des formats DAO issus d'Autocad. Intéressant, non? Bien sûr, lors de leur
prise en charge, PhotoPaint traitera ces formats comme des images en mode point.
Les formats natifs des autres applications sont également lus: PSD de PhotoShop et
XCF de Gimp; il ne manque que PSP de PaintShopPro. Le format natif de PhotoPaint,
CPT, est quant à lui, superbement ignoré des autres applications, ce qui est une criante
injustice.
Autre curiosité, les formats spécifiques de Mac que je méconnais trop pour les évoquer.
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6 Acquérir une image

L'acquisition par scanner est prévue; celle−ci passe par Sane, ce qui ne va pas sans
difficultés, parfois insurmontables en ce qui me concerne. En effet, disposant
personnellement d'un viel Umax Astra 2000P sur port parallèle, celui refuse de
fonctionner, par je ne sais quelle aberration de programmation liée à des angoisses
sécuritaires, en mode utilisateur, alors qu'il fait ce qu'on attend de lui en root. Un
comble!
A l'inverse, PhotoPaint, et pour les mêmes raisons de sécurité, ne fonctionne qu'en
utilisateur, ce qui est normal.
Evidemment, on peut toujours modifier le gfxlauncher dont il a été question
précédemment, afin que le whoami ne soit pas invoqué, et que PhotoPaint tourne ainsi en
root.

Pour les téméraires, voici la section concernée de gfxlauncher:

# warn if user is running as root
if [ "`whoami`" = "root" ]
then
    $KMESSAGE −escape −title "Warning: $name" −buttons '&Yes,,&No' "It is not
recommended to run this program as user root.\nDo you wish to continue?" 2>/dev/null
    if [ "$?" −eq "102" ]; then exit 1; fi
fi

Mais ne dites pas que c'est moi qui vous ai poussé à la catastrophe. Je nierai tout,
même sous la torture. Parce que j'ai essayé: le serveur X, la souris et le clavier se sont
gelés. Heureusement qu'il restait le poussoir de Reset en façade de la machine pour se
tirer de ce mauvais pas.
Plus sérieusement, une simple recherche dans Google sur "Linux scanner Photopaint"
vous dirigera vers les sites de HP, EPSON et bien d'autres en toutes langues, y compris
des plus inidentifiables. On devrait pouvoir trouver son bonheur sur ces sites, mais je
doute que les pilotes proposés soient gratuits.

10

http://www.linuxgraphic.org


PLAIDOYER POUR UN SOFT
par André Pascual

A  r  t  i  c  l  e  s 

I  ntroduction
Partie 1
Partie 2
Partie 3
Partie 4
Partie 5
Partie 6
Partie 7
Partie 8
Partie 9
Conclusion
Retour Index

7 CorelTUTOR

Des didacticiels fort bien élaborés sont disponibles, hélas en anglais uniquement. Ecrits
en html, leur ouverture s'opère dans Netscape après avoir opté pour CorelTUTOR dans
le menu Help. Une fois le thème d'apprentissage choisi, on navigue dans des pages
concises, comportant des hyperliens qui ouvrent des images commentées ou des
images animées. En organisant son espace de travail, ou en optant pour l'utilisation de
2 bureaux, il est très facile de mettre en oeuvre dans PhotoPaint ce que l'on est en train
de lire dans Netscape.

Six didacticiels, permettant de mettre en oeuvre un large panel de fonctionnalités du
logiciel, sont à disposition. Le dernier est axé sur l'élaboration d'un thème en accord
avec un fond d'écran pour son bureau KDE. A l'issue de ces cours, nul doute qu'on
sache vaillamment utiliser PhotoPaint, même si, dans le domaine de la création
numérique on se trouve toujours en position d'apprentissage... vérité que l'on se doit de
ne jamais oublier.
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8 Designer.com

PhotoPaint a été conçu dans une optique Web quant à son utilisation. Ainsi, >Files>
Corel online ou >Help>Corel on the web proposent différents liens vers des sites
directement impliqués dans ce logiciel. Hélas, beaucoup ont disparu en même temps
que Linux du catalogue Corel. Cependant, certains sont toujours accessibles, comme
Designer.com
Ce site est une mine pour tout infographiste. On y trouve des Freebies , notamment des
images en mode point, des cliparts vectoriels, des brosses, des informations concernant
l'impression, des didacticiels... en libre téléchargement. Hélas, bien des données
spécifiques à PhotoPaint 9 Linux ont disparu, ainsi qu'il a déjà été dit. De plus, ce qui
est présent est encore une fois en anglo−saxon pur jus, ce qui peut être rhédibitoire.
L'onglet Linux Xandros, et l'onglet OfficeCommunity est consacré à renvoie sur
WordPerfect. Quelques cliparts (en wpg) et autres images jpg peuvent y être
téléchargés.
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Mais que l'on se rassure une fois de plus: il existe en France au moins un site de
référence dédié aux outils de Corel, Corel−aide.com, de toute beauté et assez bien
fourni. Il héberge deux sections PhotoPaint, pour les versions 8 et 9, et même s'il n'est
pas question de Linux, cela n'a pas d'importance. Les versions Windows et Linux sont
identiques. Tout n'y est pas gratuit, rien n'y est en GPL, mais faute de grives on se
satisfait de merles que l'on voudra considérer comme bien dodus.
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9 Et à l'intérieur du logiciel?

On trouve tout ce dont on a besoin. Les fonctions habituelles, bien sûr, qu'il serait trop
fastidieux d'énumérer, mais aussi bien des pépites uniques sous Linux.
Par exemple, il a été dit que ce programme avait une envergure professionnelle: en
voici la preuve.

9.1 De toutes les couleurs

Lorsqu'une image se destine à un tirage papier, il faut garder à l'esprit que les couleurs
que l'on aura amoureusement choisies sur son écran ne pourront pas être reproduites
avec fidélité. Cela tient aux différents modes de synthèse des couleurs, et sans entrer
dans les détails, rappelons que le mode numérique RVB couvre une palette plus large
que le mode CMJN des imprimeurs. On peut donc très bien avoir opté pour une teinte
qui ne sera pas restituée correctement sur papier.
Le palliatif le plus évident consiste à ne pas utiliser ces couleurs trop chatoyantes, à
condition, bien sûr de les connaître afin de les éviter sûrement. PhotoPaint dispose de
deux outils qui guideront le graphiste: les nuanciers et le Gamut Alarm .
Les nuanciers Pantone, Folcotone, Toyo, Trumach, CorelDraw... sont des teintes
prédéfinies par des professionnels, que les imprimeurs peuvent obtenir avec certitude.

PhotoPaint propose une vingtaine de nuanciers différents; certains, comme Netscape
ou Internet Explorer ne sont évidemment pas destinés à l'impression. Ils assurent
simplement que ces couleurs là ne rencontreront aucun problèmes avec les navigateurs
en question.

Le Gamut Alarm consiste à recouvrir d'une couleur criarde (à déterminer par l'utilisateur)
sur la palette toutes les nuances qui ne seront pas fidèlement reproduites. Il est parfoit
étonnant de soumettre une image RVB à cette épreuve: on peut arriver à 100% de
teinte non imprimable.
Dans le montage ci−après, le petit curseur jaune sur l'échelle verticale indique la teinte
que l'on s'apprête à utiliser, le Gamut Alarm étant désactivé. En l'activant, on se rend
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compte qu'une grande partie de l'échelle se recouvre de vert: toutes les teintes
masquées par ce vert sont non imprimables. Donc, il ne faut pas les choisir. CQFD.

9.2 Harmoniser les couleurs

Sur certains tableux impressionnistes, on remarques des lumières dorées générant des
ombres mauves. L'effet produit est excellent parce que ces couleurs sont
complémentaires, c'est à dire que sur la roue colorimétrique elles sont disposées à
180°. Cependant, deux couleurs primaires ne suffisent pas toujours pour composer une
image. On pourrait avoir besoin de 3,4 ou 5 couleurs pour composer un logo par
exemple, et il conviendraient qu'elles fussent harmonieusement mêlées.
PhotoPaint propose justement 6 Mixers dans la boîte Paint Color, dont 4 sont
assemblés ci−après. Nous n'avons plus dès lors aucune excuse à utiliser des couleurs
qui jurent entre elles.

9.3 Dégradés et Motifs

Aussi harmonieux que soit un assemblage de couleurs, il ne premet que l'application
d'aplats. En conséquence, simuler le volume ou le grain d'une surface est très difficile; il
faut pour ce faire pouvoir dégrader les couleurs d'une teinte à une autre, ou remplir une
surface de motifs.
PhotoPaint sait faire cela, et il excelle dans le remplissage par des textures
procédurales (calculées), les dégradés paramétrables, et le remplissage avec des
motifs bitmap.
Sans les avoir comptés, on peut dire que plusieurs centaines de motifs sont à
disposition, ce qui donne à penser qu'on ne viendra jamais à bout d'un programme
aussi riche.
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Comme si cela ne suffisait pas, PhotoPaint autorise également le remplissage avec des
motifs divers non jointifs, grâce à une fonctionnalité tout à fait comparable au tube à
images de PaintShop Pro, appelée ici Image Sprayer. Il est facile, avec et outil, de
composer des illustrations réussies, les images du Sprayer étant de grande qualité. A
signaler que l'on trouve sur Internet des motifs librement téléchargeables (de même que
des Brushes et des Sprayers).

9.4 Status et Dockers

Autrement dit: Barre d'état et "Etabli".
La barre d'état, tout au bas de l'espace de travail contient plusieurs informations,
notamment celles concernant les couleurs. Paint concerne la couleur du pinceau, Paper
la couleur de fond par exemple lorsque l'on crée une nouvelle image, Fill la couleur ou
le mode de remplissage d'une sélection. Un double clic sur chacun de ces symboles
ouvre une boîte de dialogue appropriée permettant de paramétrer la couleur ou le type
de remplissage.
Le petit symbole avec la flèche recourbée permet d'intervertir les couleurs Paint/Paper,
et celui sans flèche de retrouver l'état initial.
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Le Dockers, est la zone verticale ou l'on entrepose les outils avec toutes leurs options,
outils auxquels on accède en activant l'onglet voulu. C'est ici que se gèrent les calques
qui portent le nom de Objects, sans doute parce qu'un calque peut se voir réduit aux
dimensions et aux formes d'une simple sélection (Ulead PhotoImpact utilise également
cette notion). Tous les calques−objets sont classiquement disposés dans cette fenêtre
de "l'établi" dans l'ordre de leur création. Evidemment, ils peuvent être, individuellement
ou en groupe, vus ou non, mélangés les uns avec les autres suivant 28 modes, recevoir
une transparence de 0 à 100%, être déplacés dans la hierarchie par drag and drop,
dupliqués, retaillés.... etc. A noter qu'un clic droit sur la vignette du calque donne accès
à des fonctions, alors que le même clic sur le nom du calque donne accès à d'autres
fonctions.
Toutefois, pour un habitué de Gimp, les manipulations des Objects PhotoPaint
nécessiteront un certain apprentissage.
Les icônes au bas de la fenêtre ont pour but de:
1 Préserver la transparence de l'Object sélectionné
2 Créer un masque à partir de l'Object
3 Créer un Object à partir d'un masque
4 Combiner des Objects sélectionnés
5 Créer un calque de réglage (Lens) selon 23 effets différents. Ceci a pour but de créer
un claque ne contenant que les paramètres d'un effet à appliquer à un calque pixel sans
le modifier. L'oeil en vis à vis de ce calque, permet de voir ou non l'effet choisi, lequel
n'est appliqué qu'au calque pixel à partir duquel on a crée le Lens. Ce concept est
absent de Gimp, mais présent dans PhotoShop.
6 Créer un Object
7 Supprimer un Object

9.5 Les filtres et effets

Ils sont classés en 12 catégories, ouvrant plusieurs centaines de possibilités
paramétrables.Là encore, j'ai renoncé à compter! Certains effets sont des plus
classiques, d'autres sont originaux et fort impressionants, en particulier
Creative>Weather> Fog, Snow , Rain. Ainsi, sur l'image suivante, comparer le rendu
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brut de Moonlight et l'image après application d'un filtre >Render>Lighting Effect et
>Creative>Weather>Rain

Et si l'on ne trouve pas son bonheur dans cette pléthore, on n'oubliera pas que
PhotoPaint d'origine Windows sait utiliser les filtres compatibles PhotoShop, les fameux
filtres .8bf. L'installation peut demander une certaine débrouillardise: en effet, beaucoup
de ces filtres commerciaux écrivent dans la base de registre qui n'existe pas sous Linux,
ce qui ne va pas sans problèmes. Certains ne fonctionnent pas. Pour ma part, j'ai
installé avec succés: Xenofex1 (16 filtres), EyeCandy3 (21 filtres gratuits), Picture Man
Collection (28 filtres gratuits), Redfield (2 filtres gratuits hors du commun) et SandWater
(5 filtres gratuits).

Ils sont installés arbitrairement dans ~/Plugcorel. Le répertoire
/usr/lib/corel/Graphics9/Plugins est un lien symbolique pointant vers ~/Plugcorel et
remplaçant le répertoire d'origine. Les .dll nécessaires au fonctionnement de ces filtres
sont stockés manuellement dans /usr/lib/corel/Graphics9/other/system, qui est pour
Wine le pseudo répertoire \windows\system. S'y trouve également Xenofex.ini, fichier
binaire créé par xenofex windows et récupéré sur ce système. Les autres fichiers ini
sont des liens symboliques pointant sur les fichiers textes ini créés dans ~/Plugcorel par
les filtres lors de leur éxécution.
Mieux qu'un long discours, voir la capture du répertoire ~/Plugcorel
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9.6 Une impression professionnelle

C'est le domaine qui fait de PhotoPaint le produit (gratuit) inégalé sous Linux. Cameleo,
est passé sous silence du fait de son prix vraiment très professionnel.
A l'activation de la fonction Print Preview, la fenêtre qui apparaît semble des plus
classiques. Il faut cliquer sur les onglets qu'offre la boîte de dialogue Settings pour
s'apercevoir que les possibilités de paramétrages de l'impression sont multiples et
inhabituelles.
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On y trouve la séparation quadrichromique, ce qui est assez courant, mais aussi la
séparation hexachromique, utilisé pour l'impression des revues de luxe. Dans ce dernier
cas, les quatre couleurs de base Cyan−Magenta−Jaune−Noir sont remplacées par des
couleurs du nuancier Pantone. On trouve également des fonction de Prepress
permettant de définir les repérages ( registrations marks) pour positionnement des
différents films de couleur, d'indiquer les barres de calibration des couleurs, ainsi que
les échelles densitométriques permettant à l'imprimeur de vérifier l'encrage.... Et bien
d'autres choses concernant le Postscript, la mise en page, les color profile ICC etc...
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Conclusion

Peut−on conclure après une visite aussi superficielle? Tout au plus se laissera−t'on
déborder par ses sentiments, qui ne sauraient prétendre faire office d'analyse. Aussi,
dirai−je sans ambage tout l'enthousiasme que PhotoPaint suscite chez moi, ainsi que le
dépit éprouvé à l'abandon de Linux par Corel, contraint et forcé sans doute.
Cependant, son produit est là, et il est bon: pourquoi s'en priver? Au vu de ce qu'il
permet, pourra−t'on encore dire, en toute honnêteté, que si Linux ne penêtre pas les
studios de création graphique c'est parce qu'il n'est pas suffisamment outillé? Les
imprimeurs accrochés à PhotoShop sur Mac peuvent−ils vraiment affirmer qu'il n'existe
aucune autre solution que celle de leurs habitudes?

Je ne répondrai pas, laissant ce plaidoyer à l'appréciation de chacun.

André PASCUAL
andre@linuxgraphic.org
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